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Overview 
Zoho CRM provides you the platform to store customer data, presents 

innumerable ways to connect with the people you work with, and gives you 

processes to nurture your prospective customers.  

You have probably observed that Zoho CRM mainly focuses on businesses and 

needs related to sales; hence, the standard modules and fields 

reflect the common types of business records involved in typical sales 

scenarios. However, we understand that every business is unique and needs a way 

to tailor the standard CRM features to best fit their needs. So, we offer a platform 

where you can extensively customize your CRM account to meet your specific 

requirements.  
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Lesson A:  

Modules 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson Objectives 

In this lesson, you will: 

• Learn about two types of modules. 

• Understand Zoho CRM’s standard modules. 

• Identify the need for custom modules and learn 

how to create them. 
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Modules 
Modules are designed to let you categorize and track various business-related 

information and data under one roof for easy accessibility and comprehension. 

Zoho CRM provides you a couple of predefined standard modules that you can 

use as-is without making any alterations. In addition to these, you can add 

modules that suit your business needs using the custom module option. Let's take 

a brief look at both kinds of modules.   

Standard Modules  
The standard modules reflect a typical sales industry in all aspects, providing 

the sales, marketing, customer support, and inventory management 

functions needed by any organization engaged in sales. These 

modules represent a standard sales process that most organizations follow. Zoho 

CRM lets you work with more than 10 standard modules such as Leads, Contacts, 

Potentials, Activities, and more, to capture your organization's process.  

Custom Modules  
Businesses with more unique sales and marketing structures may want to tailor 

modules to their own requirements, and this is where the custom modules come 

into play. Zoho CRM gives you the freedom to create modules, fields, and layouts 

based on the individual needs of your business or its industry.  These custom 

modules can seamlessly integrate with the core CRM modules and need not be 

stand-alone modules. 

To create a custom module 

1. Click Setup > Customization > Modules and Fields. 

2. Under the Modules tab, click Create New Module. 

3. Enter a name for the module—both the singular and plural forms. 

4. Click Save.
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Activity A 
Creating modules 

Before You Begin 

• Verify that you have the Modules Customization permission in your profile. 

Scenario 

Zylker operates within the finance sector and needs to customize Zoho CRM 

features to their industry's requirements. They have to create custom modules 

named Customers, Investors, and Products. 

You need to 
1. Go to Setup and click Customization.  

2. In the Customization section, select Modules and Fields. 

3. In the Customization page, under the List of Modules section, select Create 

New Module. 

4. In the Create New Module pop-up, in the Singular form of module name text 

box, type Customer, Investor,  Product or Marketing. 

5. In the Plural form of module name text box, type the plural 

name: Customers, Investors, and Products. 

6. In the Profiles section, verify if the Administrator check box is checked, and 

then check the Standard check box. 

7. Click Create to create the new module. 

8. In the Module created successfully message box, select OK to confirm the 

message. 



9  Zoho CRM for Administrators – Module  5 

 

 
 
 
 
 

Lesson B:  

Tabs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson Objectives 

In this lesson, you will: 

• Understand different views in the home tab 

• Learn to create a customized home page. 

• Check all the module tabs. 
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Tabs 
Tabs represent the different modules that Zoho CRM offers you. Customizing tab 

views enable users to navigate the CRM interface more efficiently and in an 

organized manner, thereby enhancing user productivity.  

Home Tab  
The Home tab is the start-up page that is displayed whenever you log in to your 

Zoho CRM account. It contains components from different modules like Activities, 

Deals, Dashboards, and so on, and one quick glance at the components of the 

Home tab will tell you how your sales activities are faring. Besides this, the Home 

tab also serves as a great place to organize your day's work, as well as your 

teams'. This is facilitated by the three types of views: Classic View, User's View, 

and Customized Home Page. 

Classic View: The Classic View lists three standard components: Tasks List View, 

Today's Events, and Pipeline by Stage. Because these are the critical components 

that you'll look for in day-to-day business, having these details well-organized can 

help you plan your day better. The Classic View is unique to each CRM user and 

shows the user's Tasks, Events, and Pipeline. This view cannot be customized. 

User's Home Page: Individual users can customize the home tab for their account 

in User's Home Page. A user can add only the selected components that they want 

to view in their home page. These components can be resized and moved 

around for fit and placement on the page. 

Customized Home Page: Zoho CRM allows you to personalize the home page to 

display the components that users access most often. This helps users easily 

navigate to the most frequently-viewed data by adding list views from modules. 

You can also add components such as pie charts and bar graphs from 

the Dashboard. You can share this customized view across roles in your 

organization, and every user associated with that role will have the custom view as 

their default page each time they log in to Zoho CRM. This customizable home 

page view enables the users to add frequently viewed data in Zoho CRM.  
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On the Home page, Zoho CRM shows the Customizable View by default. You can 

use the toolbar buttons to switch to Classic View. In the Customizable View, you 

can add the desired components by using the Add Components button. 

To create a customized home page 

1. Go to Setup > Customization > Customize Home Page. 

Alternatively, you can also go to the Home tab, click the drop-down on the 

top right corner and select Customize Home Page. 

2. Click New Home Page. 

3. Click Dashboard. 

4. Choose a Dashboard from the drop-down list and select components that 

you want to add to the home page. 

5. Click Custom Views. 

6. Choose a Module from the drop-down list and select components to add 

custom view components. 

7. Resize or move the components around to organize the page once all the 

required components are added. 

8. Click Save and Share. 

9. In the Edit Properties window, do the following: 

10. Specify a name for the customized home page. 

11. Choose the roles of the users with which you want to share this page. 

12. Add a description. 

13. Click Save. 

To add components in User’s Home page  

1. In the Home tab, go to User's Home from the drop-down on the top right 

corner. 

2. Click the Add Component icon. 

3. In the Add Component pop-up window, do the following: 
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a. In the Get from field, specify Dashboards or Custom Views. 

b. In the case of Dashboards, select the Dashboard from which you 

wish to add the component, enter the Component Name, and 

click Save. 

c. In the case of Custom View, select the module and the required 

custom view, enter the Component Name,. 

4. Click Save. 

The selected custom view is added as a component in your Home tab. You 

can proceed to further pages using the navigation arrows. Only five records 

are listed per page.  

Customize Column Headings in 
Components 
In the Customizable view, the components that you add in the home tab can be list 

views or data in the form of pipelines, pie charts, or bar graphs, etc. For the List 

View components you can easily add, delete, and reorder the columns. Make your 

desired changes for the list view, and they will be applied to the related 

components in the Home tab also. 

To customize column headings 

1. Click the [Module] tab (e.g., Leads, Contacts, Accounts, etc.). 

2. In the [Module] Home page, select the list view that you want to edit. 

3. Click the Edit link. 

4. In the Edit View page, select and move the fields to the Available 

Columns list box. 

5. After selecting the columns, change the order of the columns or remove 

unnecessary columns from the Selected Columns list box. 

6. Click Save. 

The changes will be applied to the related components in the Home tab. 
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All Modules 
In the above section you learned about the Home tab in detail. Now we'll take a 

look at the modules. The module tabs are the tabs that you view on the Tabs 

bar of the Zoho CRM interface, and they display all the modules that you have 

created in your CRM account. By clicking on a module you can view the 

module's home page that displays the list of records.  

You can customize the module tabs for each user by customizing the 

interface, which is specific to each module depending on your company's needs. 

By using functions like tab actions and tab groups you can organize the tabs 

to more easily view and navigate the modules that are most frequently used.  

Tab Actions 
As an administrator, you can perform three key actions using the tab settings in 

Zoho CRM to help the CRM users navigate easily across all the modules:  

• Organize Tabs: Organizing tabs will let you view the frequently used 

modules, hide those modules that are seldom used, and completely hide 

the modules that are never used. From the Setup page, you can move tabs 

up or down depending on how frequently users access them. Tabs that are 

higher on the list will always be visible to users. Tabs that are lower on the 

list will be partially hidden until users select the drop-down menu. 

Except for the Home tab, you can unselect tabs that you do not want to be 

accessible to certain users. 

• Rename Tabs: Renaming tabs will assure that you use industry-specific 

nomenclature that is well-comprehended across the teams. For example, 

the Contacts tab can be renamed “Financial Advisors” in a finance 

company. The changes made on these tabs are applied across all standard 

pages, except the Page Layout, Reports, and Dashboards modules. Once 

the tabs are renamed, the module names that correspond to the field 

names will also change.  

• Create Custom Tabs: Based on your organization's needs, you can define 

custom modules. For example, you could create new modules named 

"Investors" and "Loans." When creating a new module, you can specify to 

which profile(s) the new module will be displayed. 
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 Tab Groups 

With the Tab Group feature you can group and organize the tabs available in an 

individual’s Zoho CRM account. You can group related tabs together and share the 

group to the corresponding profiles. You can create a maximum of ten tab groups 

with multiple tabs in each group. These tab groups are accessible to users based 

on their profile permission. 

Web Tab  

The Web Tab feature allows you to add Intranet pages—such as company 

announcements and web applications—that users can open within Zoho CRM. 

Web tabs make it easier to provide company-wide information and tools to all 

users in Zoho CRM. You can create a maximum of ten web tabs and the 

administrators can give access to the users with other profiles. 

A newly-created web tab does not have any cascading effect across other 

modules, because the tabs that you create are independent in Zoho CRM. 

However, when specifying web tab names, you need to ensure that you do not 

repeat the names of the existing modules in Zoho CRM. While adding web pages 

to the web tab, be aware that some third-party websites do not allow their content 

to be displayed on other sites. 

To organize tabs 

1. Log into Zoho CRM with administrative privileges. 

2. Go to Setup > Customization > Modules and Fields. 

3. In the List of Modules page, click Organize Modules. 

4. Select the modules you want to be displayed on the tab. Clear the ones you 

wish to hide. 

You can also move around the module strips to rearrange the order in 

which the module names are displayed.  

5. Click Save. 

To rename tabs 

1. Log in to Zoho CRM with administrative privileges. 
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2. Go to Setup > Customization > Modules and Fields. 

3. Move the cursor to the module that you want to rename. 

4. Click on the More icon, and then click Rename. 

5. Enter the singular and plural forms of the module's name in the respective 

text boxes. 

6.  Select the profile(s). Users in the selected profiles will have access to the 

module. 

7. Click Save. 

To create tab groups 

1. Go to Setup > Customization > Modules and Fields > Tab Groups. 

2. Click Create Tab Group. 

3. In the Tab Group pop-up, do the following: 

4. Enter a Name for the tab group 

5. Select the tabs from the list. 

6. Select the profiles from the list. 

Users from the selected profiles will have access to the tab group. 

7. Click Save. 
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Activity B-1 
Creating a module 

Scenario 

Zylker's finance team wants to include a new module named "Assets and 

Liabilities." As the administrator, you will need to create this custom module for 

them. 

You need to 
1. Select the Setup link in your CRM account. 

2. On the Setup page, go to the Customization section and select Modules 

and Fields.  

3. On the List of Modules page, select Create New Module. 

4. In the Create New Module dialog box, in the Singular form of module name 

field, type "Asset and Liability." 

5. In the Plural form of module name field, type "Assets and Liabilities." 

6. In the Profiles section, check the Standard check box to make the custom 

module available to both Administrator and Standard profile users. 

7. Select Create. 

Activity B-2 
Grouping tabs 

Scenario 

The sales team has suggested that only the modules required by their team be 

displayed in Zoho CRM. This includes Home, Leads, Accounts, Contacts, Deals, 

Forecasts, Feeds, Products, and Activities. You decide to create a tab group 

named “Sales Team” that contains only the listed modules. 



17  Zoho CRM for Administrators – Module  5 

You need to 
1. In the Customization section in CRM, select the Tab Groups link. 

2. On the Tab Groups page, select Create Tab Group. 

3. On the Tab Group page, in the Tab Group Details section, in the Group Name 

text box, type "Sales Team." 

4. In the Tabs section, from the Available Tabs list, select Feeds, Leads, 

Accounts, Contacts, Deals, Forecasts, Activities, and Products. Select 

the Add arrow button to move them to the Selected Tabs list under the 

Home tab, which is selected by default. 

5. Select Save.  

6. In the List of Tab Groups section, observe that the Sales Force Automation 

tab group is listed and the Tabs column lists the name of the modules that 

are part of the Tab group. 

7. Select the Zoho CRM Home page. 

Activity B-3 
Creating a web tab 

Scenario 

The portfolio managers want to create a web tab for USA Today's business news 

page. 

You need to 
1. In the Customization section, select the Web Tabs link. 

2. On the Web Tabs page, select Create Web Tab.  

3. On the Create Web Tab section, in the Tab Name text box, type "Business 

News" as the name of the web tab. 

4. In the Link text box, type www.usatoday.com/money/business/. 
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5. Select Save. 

Observe that in the List of Web Tabs section, the new web name Business 

News is listed with the link to the web site. 
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Lesson C:  

Fields 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson Objectives 

In this lesson, you will: 

• Learn about standard fields in CRM.  

• Learn to create custom fields. 

• Understand module to module association. 

• Learn about formula and special fields. 
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Fields  
The Standard fields are the built-in fields in Zoho CRM that are included in each 

module. The standard fields cover the basic fields required for different types of 

organizations. These fields are visible by default, but you can hide them if 

necessary. Some standard fields can be modified; others can't be modified 

because they are mandatory fields that contain unique and critical information 

about the modules. 

Custom Fields 
Custom fields are additional fields that administrators create to store company-

specific information related to a record in Zoho CRM. Users can access custom 

fields that you include across all CRM modules. You can show or hide these fields 

from the CRM modules based on your business needs. If users are already using 

the organization's Zoho CRM, you need to gauge the impact of creating a new 

custom field on the sales process. You further need to ensure that there is no 

adverse impact on both the historical and current sales data within your 

organization. Subsequently, you need to inform users of the new field, its intended 

use, and how to implement it in the sales processes of the organization. 

The two most important pieces of field-related information that you need to 

specify for a custom field are: 

• Label: The name of a custom field. 

• Section Name: The name of the section where the custom field will be 

displayed. If necessary, you can move the custom field to another section 

by selecting it from the drop-down list.  

One of the most important points that you must keep in mind while creating a 

custom field is the field type you want based on the information the field will 

contain for your organization. The field type determines the data you store and the 

operations you perform on this data. Zoho CRM uses the field type to interpret 

data when performing tasks such as sorting records or performing calculations.  
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For example, you should choose field types such as integer, percent, decimal, 

currency, or long integer to store numeric data. This will let you sort records in the 

numerical order and perform mathematical computations on this data. If you 

create a text field and store numbers in it, you can sort the data only in 

analphabetical order. Similarly, you must avoid storing date and time data in 

numeric or text fields because you can perform sorting or calculation tasks on 

date data only if the information is entered in Date or Date-Time field types.   

Custom Field Limits 
There is a limit to the total number of fields that you can create in your account 

and also a limit to the type of fields that you create. This varies based on your 

Zoho CRM edition. 

• Custom fields are not available in the Free edition of Zoho CRM. 

• Lookup and Formula fields are not available in the Standard edition of 

Zoho CRM. 

 Custom Field Settings  
On adding or editing a custom field, you will be able to accomplish a number of 

actions within it. For example, you can edit a field's basic properties, mark it as 

required, make it a unique field, and so on. The following are the various custom 

field settings that are available in Zoho CRM: 

Add Custom Fields: In each module, you can add custom fields to capture 

important data by specifying some field-related information. 

 Edit Custom Fields: Edit the field properties to change the field label, mark it as a 

required field, or showing tool tips. 

 Set Field Permission: Set permissions like read-only, read/write, or don't show, 

based on the user profile(s) that will access the fields. 

 Mark a Field as Required: If you want the information in this field to be 

mandatory, you can simply mark it as required. 
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 Mark a Field as Unqiue: A unique field will hold explicit information about the 

client or record. For example, email 

addresses, social security numbers, passport numbers, product codes, and the like 

are examples of unique fields because they are particular to one person.   

 Remove/Delete Custom Fields: If you no longer want to use a particular custom 

field, you can remove it from the module. However, if you want to delete it 

permanently from the records, you must remove the field from the unused fields 

section.  

To add custom fields 

1. Go to Setup > Customization > Modules and Fields. 

2. Click the desired module (e.g., Leads, Accounts, Contracts, etc.) to open 

the layout editor. 

3. From the New Fields tray on the left, drag and drop the required field type 

into the desired module section on the right. 

4. Name the field and define the field properties as required for the field. 

5. Click Save Layout. 

6. Click on the More icon in the field to perform further actions like edit, 

remove, set permission, mark unique, or mark required.  

Types of Custom Fields   

Every industry has its own set of requirements, and your users may need to go 

beyond the standard CRM fields when they enter important information into your 

organization's CRM account. Therefore, Zoho CRM provides you with a varied 

range of custom fields to choose from. The following are the different types of 

custom fields that you can select based on the type of value to be entered: 

Pick List Values: A few industry-standard pick list values are readily available in 

each module by default. However, you can either add new pick list values 

or rename the existing values according to your organization's business 

processes. You can also view a record's progress over a period or different stages 

by enabling history tracking for a particular pick list value.  
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 Replace Pick List Value:- This option is applicable if you want the updated or 

replaced value of a pick list field reflected in every record to which they apply. By 

choosing the replace function, you can avoid having to update the records 

manually.  

 Multi-Select Pick List Value: You can add this pick list field if you want the users 

to be able to select more than one value for a field. For instance, your organization 

may be offering different services and some of your customers may be interested 

in multiple services. In this case you can use the multi-select pick list value instead 

of a single pick list value. You can periodically modify the available values to 

reflect any changes in your organization's processes or offerings. 

Lookup Field: A lookup field is required if you want to cross-link two different 

modules or establish a relationship between two modules so that a record's data 

is displayed in both modules.  

Example: Let's say you want to create a link between the modules “Investors” and 

“Industry” to see which industry type most of your investors are coming from. You 

can easily achieve this by adding an "Industry" lookup field in the "Investors" 

module. The related list of the "Industry" module will also list out all the investors 

associated with the particular industry. We will discuss lookup and multi-lookup 

fields in detail in the Relationship Fields section of this guide.  

Auto number Field: The auto number type of custom field classifies the records by 

unique numbers. Once the auto number field is added to the CRM module, a 

number is added sequentially to each new record. This can be also used to 

update fields in existing records like invoice number, quote number, 

and sales order.  

Currency Field: The currency field allows you to define the decimal place and level 

of precision based on your selected currency locale. There are four rounding 

options available for a currency field in Zoho CRM: Normal, Round Off, Round Up, 

and Round Down. 
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User Field: It is simpler when each record has one owner, but there are cases 

when multiple users are required to manage a record. In such instances, you can 

add a user field to the module and include the appropriate users as co-owners of 

the record. The co-owners will be able to perform actions in the record based on 

their profile permissions in the CRM account. Workflow rules can be used to 

include co-owners in email notifications, or email templates or addresses can be 

associated with the record.  

To add a user field 

1. Go to Setup > Customization > Modules and Fields. 

2. Select the module from the Modules list view. 

The Layout Editor appears. 

3. Drag and drop User field from the New Fields tray. 

4. Enter a Field Name (for example, Portfolio Manager, Investment Advisor, 

Financial Advisor). 

5. Click Save. 

Record Image Field: Some industries would like the customers to get a preview of 

their product before getting down to business. The record image 

field allows you to add an image of your product in the CRM module. 

File Upload Field:- Users can upload a file or document related to the record.  
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Formula Field: Formula fields are fields that perform calculations based on the 

values of other standard or custom fields. For example, a formula field can help a 

sales executive determine for how long a particular customer has been doing 

business with the organization. The advantage in this case is that after the 

formula field is set up, each time the records are accessed in the future, the value 

will reflect the duration for which the customer has been associated with the 

organization as of that date, rather than on the date on which the formula field is 

created. Thus the formula field is automatically re-calculated to reflect the 

changes in the values of the fields used in the formula.  

A formula field comprises three elements: function, argument, and operator. 

• Function expresses the dependence between two quantities, one of which 

is input and the other of which is output. The input values that you specify 

are processed through the function, in turn generating new values. To 

construct a function, you need to type the function name, followed by a set 

of parentheses containing the information that is needed to perform the 

function. Examples: Abs(); Ceil(); Timepart() 

• Argument is a piece of information within a function, which instructs the 

behavior of specified values. The argument helps define the values for the 

function. This information is present within parentheses and is separated 

by commas (argument 1, argument 2, etc.). The types of argument(s) in a 

function can be texts, numbers, field references, or even another 

function. The argument types are compatible with all function 

types. Examples: Abs(-27.05); Max(12,6,10) 

• Operator is a special symbol, such as "+" or "%," that acts upon the 

specified argument field type (literals, numbers, fields references) in the 

formula and returns a new value. Examples: Abs(+27.50); (32*25) 

A formula field can be further distinguished by two components: data types 

and functions. Below is a brief description of each type: 

Data Types in Formula Fields 

Data types are the defined set of values and the allowable operations on those 

values. They represent either the function, argument, return value, or the complete 

formula itself. The different data types available in Zoho CRM Formula Fields are: 
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• Numeric: The numeric data type contains numbers (digits) in various 

representations and performs calculations. The data type can be 

integral types with only whole numbers (positive, negative, and zero) 

and non-integral types with both integer and decimal parts. Examples: 

+5, -9, 10, 0 (integral types) and -25.02, 27.25 (non-integral types). 

• String: A string data type is an ordered sequence of symbols. These 

symbols can be chosen from a predetermined set of mathematical 

objects or alphabets (unicode characters).  Examples: "demo," "crm." 

• Date-Time: The date-time data type is used to store or display values 

that include both date and time or date only. Example: May 15, 2004 

11:25am. 

• Boolean: The boolean data type, also known as the logical data type, is 

used to represent the logical values of true and false. Examples:  true, 

false. 

Functions in Formula Fields 

A function performs a specific operation on values that you specify and generates 

a new value. To compose a function, you need to type the function name, followed 

by a set of parentheses ( ). There are four different types of functions in formula 

fields: 

• Numeric Functions: A numeric function in formula fields is used to 

work with numeric data types and accepts numeric results. Numeric 

functions are generally used to display the results of typical 

mathematical calculations. The numeric values (arguments) can be 

integers or decimals, positive or negative. For example, the formula can 

use number values like 10, -12, +52, etc. 

• String Functions: A string is a specialized set of characters, which can 

contain spaces and numbers, or a contiguous sequence of symbols or 

values enclosed within quotes to be differentiated from a number or a 

variable name. A string function is used to manipulate or edit the 

contents of a string. 

• Date-Time Functions: Date-time functions are used when working with 

time and date types such as identifying the day of the week for a given 

date. You can use these functions when you need the values to contain 
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both date and time information in a specified format. For instance, the 

formula can return a value as YYYY-MM-DD HH:MM. 

• Boolean Functions: A boolean function determines the value output 

based on the logical calculation of the inputs. In other words, a boolean 

function evaluates the truth or falsity of each element of its domain. It 

confirms the entities having one of two values: 1 or 0, true or false, etc,. 

along with the operations and, or, and not. 

Special Fields 

Special fields are fields that are available and applicable to specific modules. The 

types of special fields in Zoho CRM are: 

• Terms and Conditions Fields: The Terms and Conditions field enables 

you to define the standard text that expresses your company's terms 

on invoices. This field is available only for the Invoice, Quote, and Order 

modules. The Terms and Conditions field applies only for new records 

that you create after defining the Terms and Conditions values, and not 

for any existing records in Zoho CRM. 

• Tax Rates Fields: The Tax Rates field helps you define the appropriate 

tax rates that are specific to the products you sell to your customers. 

This field is available only in the Products module. When a user is 

creating a new invoice, Zoho CRM will calculate the tax based on the 

products listed. When defining the values, you need to ensure that you 

input the appropriate "tax type" and the corresponding "tax rate". 

• Contact Roles: Contact roles define the roles of the contacts or 

persons with whom you want to do business. This helps ensure that 

you are having the right discussions with the right people in an 

organization. In Zoho CRM, standard roles such as Decision Maker, 

Product Management, Purchasing, and other roles are available by 

default. You can easily customize the contact roles if desired.  

To customize contact role values 

1. Go to Setup > Customization > Modules and Fields. 

2. Select the Deals module from the Modules list view. 
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3. Click the Module Settings icon and select Contact Roles.  

 

4. In the Edit Contact Roles page, do the following: 

a. Click the Add or Delete icons to add a new role or delete an existing 

role, as required. 

b. Modify the existing roles from the Contact Role text box. 

c. Click and drag the rows to sort their order as required. 

5. Click Save after updating the contact roles. 

To add contact roles to contacts 

1. In the Deals home page, select the required deal. 

2. In the Deals Details page under the Contact Roles section, a list of contacts 

associated with the deal is displayed. Click the Add Contact Roles link. 

3. In the Contact Roles Mapping page, select the checkbox(es) of the contacts 

that you want to add. 

4. Select the select all checkbox, to associate all the contacts. 

 
5. For each contact, select the role from the Contact Role drop-down list. 

6. Click Save after associating roles with all the contacts. 
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Relationship Fields: Relationship fields in Zoho CRM let you build a connection 

between two different modules. There are two types of relationship fields that you 

can choose from depending on your needs.  

Lookup fields: Lookup fields can help you establish a relationship between two 

different modules, so that you can view relevant fields from a second module 

while still in the first module.  

To add a look-up field 

1. Go to Setup > Customization > Modules and Fields. 

2. Select the desired module (e.g., Leads, Accounts, Contracts, etc.) from the 

Modules list view. 

The Layout Editor appears. 

3. Drag and drop the Lookup field type from the New Fields tray into the 

required [Module] Section on the right. 

4. In the Lookup Properties popup, do the following: 

a. Enter a name for the lookup field in the Field Label text box. 

Example: in the Investors module, create a lookup field 

called Industries. This field will now be available when you create 

an investor.) 

b. Select a module from the Lookup Type drop-down. Data from the 

module you select here will be listed in the field.  

c. Example:, if you select Industries, the lookup field will list all the 

industries. 

d. Enter the Related List Title.  

e. Example: Enter "Other Investors." A related list will be created for 

the records in the Industries module. 

f. Click Done. 

5. Click Save Layout. 

The Industries lookup field will be found while creating investors. 

The Other Investors related list will be found in all records details pages of 

the Industries module. 

Multi-Select Lookup Fields: A lookup field will help you establish a relationship 

between two modules through a single value. Now, if you run a business that sells 
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a variety of different products, there may be situations where your client is 

interested in two or three products. In this case, to establish a relationship with 

more than one value, you need to use a multi-select lookup field that will allow you 

to link multiple values between two modules.  

Example: Zylker Real Estates manages buying/renting apartments. They have two 

modules in their CRM - Listings and Prospects. 

• Jack Smith, one of the prospects, is interested in looking at 3 listings (C-

807, B-196 & H-786). 

• Apart from Jack, 3 other prospects - Jane, Jill and Derek - are all interested 

in looking at C-807. 

This means, when the record Jack Smith is created, 3 values need to be chosen 

for the listings he is interested in. Also, the listing C-807 should have 4 prospects 

associated with it. So there is a need to choose many values from a lookup field. A 

regular lookup field lets you choose only one value. In this case, Zylker Real 

Estates could create a multi-select lookup field. Let us see how. 

To create a multi-select lookup field 

1. Go to Setup > Customization > Modules and Fields. 

2. Select the Prospects module. 

3. From the list of fields available, drag and drop the Multi-select lookup field. 

Note that you can create a maximum of two Multi-select lookup fields per 

module. 
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4. In the Multi-Select Lookup Properties window, enter the details. 

 

5. Select the Allow creating relationship-specific modules checkbox if 

a Linking Module is required and enter its name. 

6. Click Done. 

7. Save the layout. 

Linking Module: When you associate two modules using the multi-select lookup 

field, the resulting records are a combination of both the modules and thus can't 

be listed in both modules. To accommodate these records, Zoho CRM allows you 

to create a Linking Module. A linking module serves as a junction between two 

modules that are associated with a multi-select lookup field. Each association 

between two modules is created as a record in the linking module.  
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To create a linking module 

1. Select the Allow creating relationship-specific modules checkbox 

while creating the multi-select lookup field. 

2. Enter a name for the linking module.  

8. You can perform the following actions from within a linking module: 

• The related list of the associated modules will display the details of 

the Linking Module, but only if you have created a related list. 

• Customize the related list columns to display the details you wish to 

see. 

• Rename the related list as you see fit. 

• Edit a linking module's record directly from this related list by clicking 

on the Edit icon against each record. 

• Add new records to the related list or edit the existing record 

association directly from this related list. Simply click the Add or Edit 

links above the related list to do the same. 

• The records in the linking module will have no other related lists 

except Notes. 

• Create reports and dashboards based on the records in the linking 

module. 
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Activity C-1 
Creating multi-select lookup fields. 

Scenario 

An educational institute wants to establish a relationship between their students 

and courses. Create a multi-select lookup field for them in CRM. 

You need to: 
1. In Modules and Fields, select the Students module 

2. In the Layout Editor page, drag and drop the Multi-select lookup field. 

3. In the Multi-Select Lookup Properties window, enter the details given 

below:  

• Field label: Courses interested in 

• Select Related Module: Courses 

• Field Label in Related Module: Associated students 

4. Select the Allow creating relationship-specific modules checkbox to allow 

module linking and enter the name of the module. 

5. Click Done. 

6. Save the layout. 
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Lesson D:  

Stage Probability 
Mapping 

 
 
 
 
 
 
 
 
 
 
 

Lesson Objectives 

In this lesson, you will: 

• Learn about different sales stages in CRM. 

• Understand and assign stage probablity mapping.  
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Sales Stages 
Sales stages are defined steps that enable you to follow-up on the progress of the 

sales process. Each stage in the sales process is connected to the key 

activities, deliverable, or milestones to be accomplished before progressing to the 

next stage. You can provide detailed descriptions about each stage for the users' 

benefit, and you can add sales stages to the existing default stages in the CRM 

process. Some of the sales stages that are applicable across organizations are 

Launch Campaigns, Lead Generation, Lead Qualification, Work Opportunities, 

Convert Sales, and Customer Support. 

Stage Probability 
Mapping 

Stage-probability mapping helps you to identify the performance of a sales deal or 

prospect in the sales pipeline. This stage probability is mainly determined by 

values derived from two factors: the forecast type and forecast category. The 

values of these two factors define the stage of a deal sale. In the Deals module, 

you can modify the values to meet your organization's needs by adding new 

stages and assigning new probability values. Stage probability mapping helps you 

perform several operations in the sales process, including: 

• Creating different types of sales stages according to your organization-

wide sales process. 

• Associating probability values with sales stages. 

• Associating forecast types with sales stages. 

• Associating forecast categories with sales stages. 

To enhance the sales process analysis, you should assign different probabilities 

ranging from 0 to 100 to the sales stage values. When applicable, use the 

probability value 100 for  closed deals. 
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To map stage and probability values 

1. Go to Setup > Customization > Modules and Fields. 

2. Click the Deals module from the Modules list view. 

3. Click the Module Settings icon and select Stage-Probability Mapping.  

4. In the Stage-Probability Mapping page, do the following: 

5. Add the sales Stage(s) and the corresponding Probability of closing the 

sales deal by clicking on the Add icon. 

6. Delete sales Stage(s) and assign the existing Probability to another Sales 

Stage value by clicking on the Delete icon. 

 

 
 

a. To modify the existing Sales Stages, double-click inside the 

desired Stage Name and enter the new name. 

b. Click and drag the rows to rearrange the order of the stage. 

7. Click Save. 
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Activity D 
Modifying Stage Probability field 

Scenario 
In a recent sales meeting, the sales team proposed some changes to the 

company’s stage probability values and contact roles. These changes, which are 

approved for implementation, include:  

• Renaming Proposal/Price Quote as Drafting Proposal, but retaining a 

probability value of 75.  

• Renaming Negotiation/Review as Negotiating, but retaining a probability 

value of 90.  

• Adding three new proposal-related stages: Proposal Sent with a probability 

value of 77, Proposal Discussed with a probability value of 78, 

and Proposal Modification with a probability value of 80. 

• Modifying the existing contact role Purchasing to Economic Buyer.  

• Adding three more new contact roles: Technical Buyer, Business User, 

and Influencer.  

D-1. Modify the names of the two stage probability stages. 

You need to 
 

1. On the Getting Started with Zoho CRM page, in the top-right corner of the 

window, select the Setup link.  

2. On the Setup page, in the Customization section, select the Modules and 

Fields link.  

3. On the Leads: List of Fields section, from the Modules List drop-down, 

select the Deals module.  

4. On the Deals: List of Fields page, select Stage-Probability Mapping.  

5. On the Edit Pick List page, in the Stage Field Information section, in Stage 

Name column, select the name of the sixth stage, Proposal/Price Quote, 
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and press the Delete key. Type Drafting Proposal as the new name of the 

stage.  

6. In the Stage Name column, select the name of the seventh 

stage, Negotiation/Review, and press the Delete key. Type Negotiating as 

the new name of the stage.  

D-2. Add the three new proposal-related stages, set their probability, and sort 

order values. 

You need to 
 

1. In the Stage Field Information section, select Add Stage.  

a. In the New Stage Name text box, type Proposal Sent as the stage 

name.  

b. In the Probability column, type 77 as the probability value.  

c. In the Sort Order column, type 7 as the sort order value.  

d. Verify that Forecast Type is set as Open and Forecast Category is 

set as Pipeline.  

2. In the Stage Field Information section, select Add Stage.  

a. In the New Stage Name text box, type Proposal Discussed as the 

stage name.  

b. In the Probability column, type 78 as the probability value.  

c. In the Sort Order column, type 8 as the sort order value.  

3. In the Stage Field Information section, select Add Stage.  

a. In the New Stage Name text box, type Proposal Modification as the 

stage name.  

b. In the Probability column, type 80 as the probability value.  

c. In the Sort Order column, type 9 as the sort order value. 

D-3. Modify the sort order values.  

1. For the Negotiating stage, in the Sort Order column, change the value from 

7 to 10.  

2. For the Closed Won stage, in the Sort Order column, change the value from 

8 to 11.  
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3. For the Closed Lost stage, in the Sort Order column, change the value from 

9 to 12.  

4. For the Closed Lost to Competition stage, in the Sort Order column, change 

the value from 10 to 13.  

5. Select Save to save the changes. 
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Lesson E:  

Validation Rules 

 
 
 
 
 
 
 
 

 

 

 

 

Lesson Objectives 

In this lesson, you will: 

• Understand validation rules. 

• Learn how to validate fields in Zoho CRM.  
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Validation Rules 

As your business expands, your sales increase in leaps and bounds and so does 

the number of customers you deal with. You can imagine it multiplying a hundred 

times over if your business manages to attract global acclaim. As you expand, it 

can become a challenge to ensure the validity of the data in your CRM. Your 

employees rely on the data that they see, and poorly-maintained data can cost 

your company in more ways than one: slowing down your activities, costing you 

accuracy in reporting, and the plain annoyance of manually verifying the details of 

each record when you have more important activities to deal with. 

Here come validation rules to the rescue. They help you restrict invalid data, or the 

wrong kinds of data, from entering your CRM system.  

The Basics of Validation 
Rules 
There are some important aspects of validation rules that you must keep in mind:  

• Validation rules allow you to define how you don't want your data to be. 

That is, you will define the undesirable values for a field in a validation rule. 

If a field value entered for a record matches the criteria defined in the rule, 

CRM will display an alert and will not allow the record to be saved.  

•  The error message is customizable.  

Example: You don't want deal discounts ever to be greater than 15%. If you were to 

set this validation rule in CRM, the instructions for your validation rule would be 

the following: 

• "If Discount is greater than 15% throw an alert message." 

• Error to be displayed: "Sorry! We don't allow a discount greater than 15%." 

You can further drill down the rule by defining different custom error messages 

based on specific criteria. For instance, you can specify that the discount for India 

should not be greater than 15%, but the discount for the UK can be up to 20%. Here 
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you will have branch conditions for the discount fields and specify appropriate 

error messages. You will learn more about these multiple conditions in the 

following sections. 

To create a validation rule 

1. Go to Setup > Customization > Modules and Fields. 

2. Select the module for which you want to create the validation rules. 

3. In the [Module] page, click the Validation Rules tab. 

4. Click + Create Validation Rule. 

5. In the Create Validation Rule pop-up window, perform the following actions: 

a. Choose the layout that the field you wish to validate belongs to. 

b. Choose the field and define the primary condition to initiate the 

rule. 

For instance, if you want to validate the discount field to keep out 

discounts more than 15%, your primary condition will be "Discount > 

15%" 

6. Click Next. 

7. In the Validation Rule Editor, enter the alert message that should be 

displayed for records that meet the condition. 

Example: Sorry! We don't allow a discount greater than 15%.  

Note that this error message will be displayed for all the records that meet 

the criteria. With this rule in place, whenever a user attempts to create a 

deal with more than a 15% discount, this error message will be displayed. 

8. Move the cursor over the More icon and click Edit. 

Example: Zylker's policies define allowable discounts based on sales 

regions. For India, the maximum discount that can be offered is 15%, but in 

the UK it can go up to 20%, and so on. You can define these additional 

conditions in the validation rule and customize the error messages as 

required. 

9. In the field Which records would you like to apply the rule to? 

select Choose based on specific conditions. 

10. Define each condition and specify the appropriate error message. 
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11. Click Add another option to change the value of the primary field and 

configure different alert messages as required. 

12. Click Save. 
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Lesson F:  

Module Views 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lesson Objectives 

In this lesson, you will: 

• Discover the benefits of different types of views.  

• Create and choose the right type of view.  
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Module Views 

A module view defines the way a list of records for a specific entry is displayed. A 

view defines the following: 

• The columns that are displayed in the module 

• The way list of records are sorted by default 

• Default filters that should be applied to display only the relevant records   

Apart from the above benefits of a default view, there can be requirements in your 

business that compel you to change the display, like better comprehension of 

data, ease of data retrieval, or product image display. To address such necessities, 

Zoho CRM provides you three different types of module views: List View, Kanban 

View, and Canvas View. 

List View 

A list view groups the records based on a defined set of criteria. It is helpfull for 

displaying customer-specific data according to a business's unique needs. For 

example, you may be interested in following up on the leads created during the 

last week, or reviewing overdue tasks, or you may want to filter out big deals. The 

best way to handle scenarios like these is to filter the records using the list views. 

You can also use the list views for changing record owners, deleting records in 

bulk, and sending mass emails.  

List views are categorized under Created By Me and Shared With Me. You can 

also mark list views that you often use as Favorites and those will be listed first in 

the List View drop-down. Just click the star next to a list view and it will be 

available under Favorites. There are two types of list views: 

• Standard List Views: In the <Module> Home page, you can select the 

required list view from the View drop-down list. Only the standard view 

modes allow you to rearrange the order of the columns or add more 

columns. Some of the standard list views are All Records, My Records, 

Recently Created Records, Recently Modified Records, Recently Viewed 

Records, etc. You cannot delete these list views. 
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• Custom List Views: You can create list views and define the criteria by 

which the records are filtered. You can modify and delete the custom list 

views and also sort the order of the columns in the list. 

Setting up Permissions for the List View 
In the Accessibility Details section, define the user's permissions to view the 

custom lists. The following options are available: 

• All users are allowed to view this custom view. 

• Show this custom view only to me. 

• Allow the following users to view this custom view. 

Select All Records in a Custom List View 
You can select all the records that belong to a particular custom view in one shot. 

Consider this scenario: you wish to change the record owner of all leads in the 

custom view called Tradeshow leads. Say you have over 20,000 leads in this 

custom view—it's a hassle to keep navigating to the "Next" page and selecting all 

leads on every page.  

Instead, you can simply click the Select All [Records] in this View link. All 20,000 

leads will be selected in one shot and you can change the owner for all these 

records easily. All the records in that list view will be selected. 

Once all the records in that custom list view are selected, you can perform the 

following bulk operations on those leads. 

• Mass Update 

• Change Owner 

• Delete 

After you have applied a mass update/change owner/delete action, the progress 

bar at the bottom right corner of your screen will let you know about the status of 

the update. 
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To create custom views 

1. Click the [Module] Tab (e.g. Leads, Contacts, Accounts, etc.). 

2. In the [Module] Home page, move your cursor to the list view's drop-down. 

3. Click the Create View link. 

4. In the New View page, do the following: 

a. Enter the custom View Name. 

b. Mark as Favorite, if required. 

The custom list views marked as favorite will be listed first in the 

list view drop-down. 

c. Specify Criteria to filter the records. 

Tags can also be used as part of Criteria to filter records.  

d. Select the columns to be displayed in the module view. 

e. Under the Share this with section, choose who can see this view. 

5. Click Save. 

Kanban View 

Kanban view is a card-based view that displays the data in an organized manner 

for better comprehension.  

For example, you can segregate the leads based on their status or categorize the 

sales depending on different stages. This sort of information gives you better 

insights about potential bottlenecks and lets you fix them effectively. Thus, 

kanban view presents your CRM data in a more productive manner. You can create 

kanban views across all the CRM modules. There are two types of kanban views: 

Pre-defined and Customizable. 

A) Pre-defined – The pre-defined kanban views are available for Activities, Social, 

Visits, Deals, and SalesInbox. Below is the CRM view for the Activities module, 

based on Customers, Open Deals, Leads/Contacts, and Others.  
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B) Customizable - You can create a customized Kanban view for any module. All 

you need to do is provide a few details:  

• Kanban View Name: You can enter any name for the kanban view created, 

for example "Lead Details." 

• Categorize By: Select the category in which you want to segregate the 

data, for example "Lead Status." 

• Aggregate By: Select a currency or number field for which you want the 

aggregated value, for example "Expected revenue/Number of user 

licenses." A summed-up value for each category will be displayed. 

• Select Fields: Select the fields that you want to view within each record.  
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Working with kanban view 
Creating a kanban view will give you precise information about all the records at 

one click. You can create a kanban view for all the modules except Activities, 

Visits, and Finances. 

In addition to viewing the record details in an organized manner you can perform 

several other operations from the kanban view. Let's take a look at each of them: 

Drag and Drop: You can drag and drop a record from one column to another based 

on your requirements. For instance, a lead listed under Attempted to Contact has 

declined the present offer and you want to keep them in the pipeline for future 

reference. So, instead of editing the record and changing the status, you can 

simply drag and drop the record to the desired column to automatically change 

the status. The aggregated value of the respective columns will also be updated. 

Mass Operations: You can send mass emails, create tasks, create macros, and so 

on. From the More Actions icon, you can change owner, mass update a field, mass 

convert the leads, or delete leads.  

Select a Layout: A user can select a layout in which they want to view the module.  

Sort Records: A user can sort the records based on the fields they want to view 

like company, first name, last name, lead owner, and so on. 

To create a kanban view 

1. Click the [Module] Tab (e.g. Leads, Contacts, Accounts, etc.). 

2. In the Module page, click the Kanban View icon. 

3. In the Kanban View Settings pop-up, fill in the following details: 

• Kanban View Name 

• Categorized By 

• Aggregate By 

• Select Fields 

4. Click Save. 
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Canvas View 

Canvas View lets you sculpt an exclusively personalized view of the records. You 

can customize, add record images for better identification, use custom buttons to 

represent the fields, use a particular font style or size, change the alignment of 

field types, group similar field types, and much more.  

Additonally, you can choose from a gallery of design templates, or create and 

customize your template with specially-crafted design tools. The design layout 

editor lets you define additional customizations to the records display. 

Design Layout Editor  

The design editor consists of many tools that you can use to give your module a 

personalized and unique look. A few of the design elements are: 

• Style: You can choose from a wide range of styles to mark your data as 

vital information, secondary information, highlight grey, paragraph text, 

subtle information, date & time, low priority, and more. 

• Font Size: Select font size from the range of 11px to 21px. 

• Group: Group two or more fields. Grouping is perfect when a customer has 

to enter lengthy text or text that has many characters. The field text box 

automatically expands to accommodate the entries without compromising 

the text alignment.  

• Shuffle data: Use this option to shuffle the CRM records within the 

template.  

• Label: Toggle off the label icon if you do not want the field label to be 

displayed.  

• Color: Choose a text or background color for the field entries. You can 

select a color from the default list or create your own color palette. 

Design & Build Canvas View 
You can build a canvas view by choosing a predefined design template or creating 

your own template from the scratch. You can create a canvas view for both 

standard and custom modules except the Activities module. For designing and 

building a canvas view, follow the steps below: 
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Step 1. Create canvas view 

1. Select a desired module. 

2. Click the Canvas View icon  . 

You will be redirected to the Canvas View page. 

3. Click Create Your First Canvas View to continue. 

Next, you will have to choose a design template or build your own 

template. 

Step 2. Choose a design template or build your own canvas view 

Once you choose to create a canvas view for a particular module you can do either 

of the following for creating a design template: 

Choose a template: Zoho CRM lets you choose from an array of pre-defined 

templates. The templates involve a variety of categories like People, Help Desk, 

Real Estate, Automobile, Organization, and so on. 

Build your own view: This option lets you build your own canvas view. You will be 

using additional customization options available in the layout editor for creating a 

personalized view of a module.  

To choose a template: 

1. In the Choose Template page, select a category from the available options. 

You can choose from People, Organization, Deals, Product, Help Desk, Real 

Estate, and Automobile. 

2. Choose and click on a template. 

3. In the Field Mapping page, select a field and choose any field from the 

drop-down list to which you want to map. 

4. Click Next to continue. 

Next, you will be redirected to the Canvas View Builder page to design your 

layout. Refer to the layout editor table below for designing details. 

5. Click Save. 

6. Enter a name for the canvas view created. 
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To build your own view: 

1. In the Choose Template page, click Blank Template. 

2. In the Canvas View Builder page, design your layout. 

3. Drag and drop the fields into the blank template (e.g., Account Owner, 

Account Name, etc.). 

4. Edit the template design. 

Refer to the layout editor table below for designing details. 

 

 

The below layout editor table describes the designing tools available in the canvas 

builder: 

Design 
Item 

Description Types 

Style 

Define a style in which the field 

name will appear. You can 

choose from the 12 available 

styles. 

• Normal Text 

• Record Name 1 

• Record Name (Blue) 

• Record Name 

(Green) 

• Vital Information 

(Orange with bold 

font) 

• Secondary 

Information 

• Highlight Grey 

• Highlight Blue 

• Paragraph Text 

• Subtle Information 
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• Date & Time 

• Low Priority 

Font Size 

Choose the font size in which 

the field text will appear from 

the drop-down list. 

• Range of 11px to 

21px. 

Font Type Select the field text style. 

• Thin 

• Light 

• Regular 

• Semi-bold 

• Bold 

• Extra bold 

Italics 
Select if you want the field text 

to appear in italics. 
• I 

Strike 
through 

Select if you want to strike out 

the field. 
• ab 

Capital 
Select if you want the field text 

appear to appear in all caps. 
• AA 

Color 

Choose a text or background 

color for the field entries. You 

can select a color from the 

default list or create your own 

color palate. 

  

Text 
Alignment 

Select either left, right or 

center alignment for the field 

entries. 
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Spacing 

Increase the spacing between 

the fields up, down, left and 

right. 

  

Label 
Toggle off the label icon if you 

do not want the field label to be 

displayed.  

  

Icon 

Select the custom buttons to 

represent a field label from the 

drop-down list. 

  

Copy 
Style 

Copy any of the defined field 

label or value style. 
  

Paste 
Style 

Paste the style to the selected 

field label or value. 
  

Group 

Group two or more fields. 

Grouping is perfect when a 

customer has to enter lengthy 

text or text that has many 

characters. The field text box 

automatically expands to 

accommodate the entries 

without compromising the text 

alignment.  

  

Ungroup 

Ungroup the fields if you no 

longer want them in a single 

text box. 
  

Delete 
Select a field and delete if 

required.   
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Undo and 
redo 
arrows 

Using the two arrows, you go 

back and forth to change the 

design. 
  

Shuffle 
data 

Use this option to shuffle the 

CRM records within the 

template.  
  

Step 3. Preview the template 

Once the template is designed, you can preview it. If required, you can make any 

necessary changes before saving.   

Step 4. Share the canvas view 

You can choose to share the canvas view that you have created. You can share 

the view either with all the CRM users or choose a selected list of users. The CRM 

users will be filtered based on roles, groups, users, or roles and subordinates. 

1. Click Save once the canvas view has been created. 

2. Enter a name for the view. 

3. In the Share this with field, choose one of the following: 

• Only me 

• Everyone 

• Selected users: For Select Source type, choose and add users from 

either Groups, Roles, Roles and subordinates, or Users. 

4. Click Save. 

Manage, Edit and Create Additional Canvas Views 
If required, you can edit a canvas view that has been already created and create 

more than one canvas views for a module. 
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To edit and create canvas view: 

1. In the Module page, go to the Canvas View and click Manage from the drop-

down list. 

2. In the Manage Canvas View page, choose either Edit, Clone, Share, 

or Delete. 

3. Click Create Canvas view from the drop-down to create another view in the 

module. 



57  Zoho CRM for Administrators – Module  5 

 

 

 

 

 

 

Lesson G:  

Related Lists 

 
 
 
 
 

 

 

Lesson Objectives 

In this lesson, you will: 

• Learn about related lists  

• Learn to add related lists from different sources 
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Related List 

The Details pages of specific modules contain details of records from other 

modules. The record details from other modules that appear as part of another 

module's Details page are referred to as related lists. The related lists feature 

provides an association between records in the current module with related 

records that are available in other modules of Zoho CRM. For example, on the 

Accounts Details page, the details of the Contacts and Potentials modules are 

listed. 

In all Zoho CRM editions, you can customize the related lists by selecting 

Setup→Customization→Related List. On the Related List Columns page that 

displays, you can customize the related list by selecting the list of columns that 

need to appear on the Details page of a module. Further, you can reposition the 

fields based on your requirements. 

The enterprise edition of Zoho CRM provides another feature called custom-

related lists, which can be accessed from the Record Details view of specific 

modules by selecting Settings→Add Related List. The custom-related lists allow 

you to access data that is collected from sources such as pre-defined third-party 

custom functions. The custom-related lists can be added to the Leads, Contacts, 

Accounts, Campaigns, Potentials, and Vendors modules. However, you can 

customize the fields or columns in the related lists in all modules.  

Adding a Related List 
You can pull data from various sources to create related lists with two options: 

• Zoho Creator's Custom Apps: Add records from Zoho Creator Apps 

as related lists. 

• Third-Party APIs  - Add Third-Party APIs as related lists. You can either 

choose from pre-defined functions from the gallery or create your own 

functions. 



59  Zoho CRM for Administrators – Module  5 

Use Custom Applications as Related List 
You can extend your CRM platform with Zoho Creator custom applications . The 

forms and views can be used as custom tabs inside Zoho CRM. If you have Zoho 

Creator Integration activated in your Zoho CRM organizational account, you can 

view the records of a Custom App's view using a custom related list in your CRM 

modules. 

Third-Party APIs as Related Lists 
Using APIs, you can add third-party services as related lists into Zoho CRM 

modules. You can either use the pre-defined third-party custom functions from the 

Gallery or create a custom function for the third-party service you wish to add in 

the related list. 

You will need to call the API provided by the third-party vendor, and parse the 

response. The response has to be formatted to suit Zoho CRM.  

Zoho CRM offers some pre-defined functions that are ready to use. Browse 

through the gallery and select a function that suits your requirements. The 

selected function will be added to your list of custom functions. You can then use 

this function as a related list anytime. The following are the third-party contextual 

integrations that are provided by CRM:  

• Zoho Recruit 

• Contactology 

• Saasu 

• FreshBooks 

• Zoho People 

Create Custom Functions 
In addition to the pre-defined functions from the gallery, you can also write your 

own custom functions using Deluge script.   
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Deluge Script 
Deluge, short for Data Enriched Language for the Universal Grid Environment, is an 

online scripting language integrated with Zoho Creator. It enables users to add 

logic to the application, incrementally, making it more powerful and robust. The 

entire database layer is abstracted, and while scripting in Deluge you will only 

speak in terms of forms and fields.  

Custom Function 
A function is a set of statements grouped together under a name and can be 

invoked from anywhere within a program. Deluge scripting supports functions, 

which allow us to structure the script in a more modular way, accessing all the 

potential that structured programming can offer. Related functions can also be 

grouped under a common category based on their purpose, called names pace, 

which helps in easy maintenance. Functions can be invoked from form/field action 

scripts or on selected records in a view. 

To use a custom app to create a related list: 

1. Click a Module (tab) and select a record. 

2. In the Record Details page, click Add Related List. 

3. In the Add Related List pop-up box, click Custom Apps. 

All the Zoho Creator custom apps that are shared to your account will be 

listed. 

4. From the list of custom apps, click Add Now for the corresponding app 

that you want to use. 

5. In the Add Related List page, do the following: 

a. Specify a name for the Related List. 

b. Choose a Form from the drop-down list. 

c. Based on the form that you choose, the associated views will be 

available. 

d. Choose a View from the drop-down list. 

e. The selected view will be used as the related list for the module. 

f. Specify a criterion for Fetch records for the related list only if [Zoho 

CRM field value] matches with [Custom Form field value]. 



61  Zoho CRM for Administrators – Module  5 

g. Select the check box of the fields that you want to view in the 

related list.  

6. Click Save.  
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Lesson H:  

Custom Links & Buttons 

 

 
 
 
 
 

 

 

 

 

Lesson Objectives 

In this lesson, you will: 

• Learn about custom links and buttons 

• Provide permission to the custom links 

• Learn different ways to add a custom buttons 
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Custom Links 

The Custom Links feature enables users to access third-party links that are added 

in their account. Once the custom links are set, they can be viewed in the account 

owner’s page. The number of custom links that you can create is based on your 

Zoho CRM edition.  

Employees may need to gather information related to sales activity by accessing 

external web sites. You can add links to these external web sites so that users can 

easily access them. The Fields & Links Permissions page provides you with 

options for giving or revoking access permissions for the custom links. You can 

also hide the existing links based on your organization's requirements. Here are 

some examples where custom links in Zoho CRM can be used: 

• Accessing your contacts' Twitter profiles: All the contacts in your account 

can have a field where you specify their Twitter ID. By creating a link for 

Twitter, you can directly go to the contact's Twitter profile in a single click. 

Example: The link can be: https://twitter.com/#!/${Contacts.Twitter ID} 

• View maps: Zoho CRM provides the Locate Map option to view the address 

of the contacts in Google Maps. If you want to view the address location 

using some other application, then you can define a link. 

Access Permissions to Custom Links 

There can be a requirement to access external sites or applications to see 

required sales information. In such cases, when custom links are created, you 

need to authorize the usage of such external sites by providing access 

permissions to links.  

To add custom links 

1. Go to Setup > Customization > Modules and Fields. 

2. From the list of modules, select the required module. 

3. In the Links and Buttons tab, click Create New Link. 

4. In the Create New Link page, do the following: 
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a. Enter a name for the link in the Label text box. 

The label should not exceed 50 characters. 

b. Enter a description for the link. 

The description should not exceed 250 characters. 

c. Enter the value to construct the URL. 

The URL length should not exceed 3000 characters. 

d. Select the Field from the drop-down list. 

On selection, the field variable will be inserted as part of the URL. 

e. In the Set Permissions section, choose the user profiles that are 

allowed to access the links. Users who have "Customize Zoho 

CRM" permissions in their profile can set access permissions for 

the links at the time of creating the links. Based on these 

permissions, other users can use the links. 

 

5. Click Save. 

The link will be available in the Record Details page. 
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 Custom buttons 

The standard buttons in Zoho CRM are used to execute various predefined 

actions. For example, Convert is a standard button used to convert a Lead to a 

Contact, Account, or Potential. Similarly, Clone is another standard button that is 

used to clone any record within your CRM account. Likewise, you can create new 

buttons and define a set of actions based on the requirement. Custom buttons can 

also be used to connect your CRM with third party applications, connect different 

Zoho CRM modules, or connect other Zoho applications.  

Define Button Action 
Every custom button should be associated with an action when a user clicks the 

button. You can define your button action any of the following ways: 

From gallery: There are a few ready-to-deploy button actions in the gallery, which 

you can associate with a custom button for different business scenarios whenever 

required. For example, you can use the Recurring Potential button to repeat a 

potential for a certain period of time. You can create a custom button that will 

clone a particular potential record information for the next one year.

 

From existing actions: Existing actions are predefined button actions created by 

users in an organization. This option will be available only when you have already 

created custom functions for custom buttons in your CRM account. These actions 

can be reused with different custom buttons whenever required. 

Define your own button action: You can define your own button action in the 

following ways: 
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• By writing a custom function: With the help of the Deluge Script Editor, you 

can write your custom function and define the button action. When writing 

a custom function, you can initiate response tracking that will create an 

alert or pop-up notification whenever you click on the custom button. If any 

open URL tasks are configured in custom function, the last opened URL 

task will be opened either in a new tab or a new window or a pop-up 

window.  

• By invoking a URL: Using Invoke a URL, you can open a URL in a click of a 

button. This will open a desired action either on a new window, or the 

existing window or on a new tab. 

• By opening a web tab: This action allows to open a web tab in a new tab 

along with the associated merge fields in just a click of a button. You can 

either create a new web tab or choose from the list of web tabs that have 

been already created and associate the tab with your custom button. 

Sort or Edit Custom Button 

You can edit and sort the custom buttons as and when required. If you have 

created many custom buttons in your account, you can sort the order in which the 

buttons are visible in the module/record.  

To create a custom button 

1. Log in to Zoho CRM with administrative privileges. 

2. Go to Setup > Customization > Modules and Fields. 

3. From the list of modules, select the required module. 

4. In the Links & Buttons tab, click Create New Button. 

5. In the Create Your Button page, do the following: 

a. Enter the name of the button.  

The button name should not exceed 30 characters. 

b. Click the Add Description link and specify the details of your 

custom button. 

The description should not exceed 250 characters. 

c. Choose the location of your custom button from the drop-down list. 

Custom buttons can be placed in 6 different places in your CRM 
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account: Create/Clone page, Edit page, View page, List View page, a 

button for each record in the list view, and the Related Lists Page. 

Note that you can create up to 50 buttons for each module. 

d. Choose an action to be executed when a user clicks the custom 

button. You can either choose a predefined action from the gallery 

or an existing action that was already created by users in your 

organization. You can also define your own action by writing a 

custom function, open a new web tab, or invoke a URL based on 

your needs. 

6. It is mandatory to choose the button action. Click Save. 

Once the custom button is associated with an action, CRM administrators 

can manage permissions by assigning only specific profiles to view and 

access the custom button. 
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Activity H 
Creating a link 

Scenario 

The sales team would like to gather more information about prospective leads by 

accessing the leads' websites. However, to save time, they want the websites to 

be accessible from within the module details page. To check out this functionality, 

you decide to add links to two lead websites, namely www.twitter.com and 

https://plus.google.com. In addition, you decide to hide the second link as you 

need to get authorization before you allow access to this link within your 

organization.  

You need to  
1. Create custom links to https://www.twitter.com and 

https://plus.google.com websites in the Leads module.  

2. Choose a module and click the Links and Buttons link. 

3. In the Create Link page, in the Label text box, type "Twitter" as the name of 

the link.  

4. In the Description text area, type "Contains link to Twitter" as the required 

description.  

5. In the Construct Your Link section, in the URL text area, type 

"https://www.twitter.com" as the website’s URL. 

6. Select Save to save the new link. 

7. Repeat steps 1c through 1g to create a link named Google Plus to link the 

Google Plus website using https://plus.google.com as the URL. Provide a 

suitable description for the new link. 

8. Assign permissions to the custom links. 

9. In the Create New Link page, go to Set Permission. Select the users who 

should have access to the links. 
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Templates 

 

 
 
 
 
 

 

 

 
 
 

Lesson Objectives 

In this lesson, you will: 

• Learn about tyopes of templates 

• Learn to customize templates 
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Templates  
In any business organization, frequent communication takes place with external 

organizations and customers as part of the daily routine. Some of these business 

communications will be repetitive in nature; the effectiveness of such 

communications can be maintained by creating and adopting a standard format.  

By having standard formats for business communications, there will be clear 

understanding and consistency in the text that is being exchanged. It will ensure 

that only relevant information is communicated and make it easier to track or 

collate the mails in the future. Zoho CRM allows you to create templates, which 

help you to achieve the required standardization of business communication. In 

this module we will discuss three types of templates: email templates, inventory 

templates, and mail merge. 

Email Templates  

Email templates are master documents that allow you to specify the standard 

format for emails. You can apply suitable formatting, include relevant images, and 

add HTML code to finalize the content of the email message. In email templates, 

you can include fields from the selected modules. When you create an email 

message based on email templates, the field values will be displayed instead of 

the field names.  

 In Zoho CRM, you can also clone, modify, and delete email templates depending 

on your business needs. These email templates are module-specific. For example, 

if you want to send an email to your contacts, Zoho will only show you the 

templates created for contact records.  

 While creating email templates, keep these points in mind:  

• A template can contain a maximum of 32,000 characters.  

• A video cannot be embedded in a template, but a link to a video can be 

included.  



71  Zoho CRM for Administrators – Module  5 

• When creating an email template for leads, make sure that you don’t 

include contact-related fields. Otherwise, you’ll experience errors while 

creating the email template.  

Create New Template 

You can create email templates either from scratch or from predesigned 

templates. All you have to do is drag and drop components onto the template to 

create it. An All Components panel will be available when creating a template, 

from which you can drag and drop the components you want. With predefined 

components the level of customization needed is very little. If you choose a 

predesigned template, all you need to do is select a template from the gallery, add 

the HTML codes, and save it.  

 View Template Analytics 

The template analysis can give you an insight into the performance of each 

template. Whenever changes are made to the template, it is considered as a new 

version of the template. This lets you analyze how each version of the template 

has performed and gives you an idea of how well the implemented changes have 

been accepted.  

 By clicking on the analytics tab or the open rate under the stats column you can 

view the template analytics. A graph with the template statistics will be shown. 

1. You can toggle between: 

• Open Rate: The opened rate is the percentage that tells you many times 

the email containing the template has been opened by the customers. 

• Click Rate: The clicked rate is the percentage that tells you how many 

clicks were registered by the customers for that particular email 

containing the template. 

• Version: The Version tab lists when a template was modified and by 

whom. Click on it to view a summary of the template with details such 

as different versions, open rate, click rate, when it was modified, and by 

whom. 
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2. You can choose to view the graph based on the Percentage, Count, or 

Version from the drop-down list. 

3. You can choose whether you want a specific version or all versions to 

appear on the graph. 

4. You can define the range of dates for which the data should appear on the 

graph. 

 

Sort and Search Email Templates 
Sorting makes it easier for you to access the templates that you need, by bringing 

them to the top of the list. For example, you can sort the templates in such a way 

that the most used templates appear at the top of the list. In Zoho CRM, in 

addition to sorting templates, you can also search for templates. 

• You have two options for sorting templates based on time: 

To sort based on the last use time, click on the Last Used column. With the 

help of the Last Used column you can get to know which templates are 

used the most. 

To sort based on the modified time, click on the Modified Time column. 

• You can also search and filter templates based on your needs. 

• You can search for a template by its name with the help of the provided 

search bar. 

• Choose the module from the drop-down list to display the templates 

related to that particular module. 
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Clone Email Templates 
At times, there might be slight changes that have to be made to the content of an 

existing template, before sending it to a customer. Rather than having to go 

through the trouble of creating a whole new template, you can clone the old 

template, make the necessary changes, and send it.  

Associated Templates 
There can be instances when some of the templates are associated with other 

CRM functions like Workflow, Case Escalation, Macro, etc. In these instances, you 

can view the functions with which the template is associated by clicking on the 

button that appears at the end of the template details. You can group 

together similar templates and move them to an appropriate folder. When 

necessary you can share the template folders with the required set of users or 

groups.  

Use Email Templates 
There are several cases where you can send emails by using the email templates. 

The following are ten instances in which you can make use of the email template:  

• Send Mail 

• Mass Email 

• Schedule Mass Email 

• Auto Responders 

• Macros 

• Workflow Automation 

• Approval Process 

• Case Escalation 

• Webforms 

• Auto Response Rules 

Inventory Templates 

You can use the Inventory Templates page to customize templates related to the 

primary inventory modules—namely Quotes, Purchase Orders, Sales Orders, and 
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Invoices—and create a print layout based on your business requirements. The Edit 

function allows you to change the print layout fields, place the company logo 

appropriately, enhance the look and feel of the layout, and align the list of products 

and services. You can create new Inventory templates by linking primary inventory 

modules with secondary modules. As with email templates, you can either build a 

template from scratch or select one from the template gallery.  

Guidelines for Creating an Inventory Template  

When creating an inventory template, you need to ensure that you follow certain 

rules that are applicable in Zoho CRM. Follow these guidelines to create your 

inventory template:  

• The Product Name field is a mandatory field in any inventory template. It 

enables the listing of a product in the inventory document from the 

available products in Zoho CRM.  

• The specific template tags for line items should be present within <tbody 

id="lineItem"> and </tbody> tags.  

• You can merge fields from other modules such as Users, Organizations, 

Accounts, Vendors, Contacts, and Deals.  

• The default templates can be used in the Print Preview, Export to PDF, and 

Send Mail functions of the Quotes, Orders, and Invoices modules.  

 Other Functions in Inventory Template 

As with email templates, you can perform other actions like creating template 

folders, sorting the folders, and cloning templates, as well as sorting and 

searching inventory templates.   

Mail Merge Templates 

The mail merge feature helps streamline repetitive tasks that are involved in the 

creation of customized documents, such as forms, letters, and envelopes. With 

the mail merge feature, you can create mail merge templates and import 

templates containing merged fields. These merged fields collect data from Zoho 

CRM records and display them in the generated document.  
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For example, if you have to send out personalized letters to all contacts 

simultaneously, you need not type the details that correspond to each contact 

manually. Instead, you can create a template with the merged fields from the 

Contacts module and then merge the data to generate the personalized letters.  

Benefits of Templates 

The mail merge templates help you merge fields from Zoho CRM modules to 

generate personalized documents, such as forms, letters, and envelopes. While 

using the mail merge template, you can either create templates using Zoho Writer 

or import Microsoft® Word templates. 

The Import Template option allows you to import Microsoft® Word documents 

that are no larger than 2 MB. Word documents can either be in .doc or .docx 

formats. You should type a brief description of the imported document in 

the Description text box. You can also select the folder in which you want to store 

the template. Finally, you can select the module in Zoho CRM that is needed for 

the mail merger. 

 Create Templates 

You can create mail merge templates using Zoho Writer or MS Word. Let us look 

at each in detail: 

Zoho Writer  

Zoho Writer is an online word processor that allows you to create and share 

documents in a rich-text format (RTF). Zoho Writer lets you create mail merge 

documents online using Zoho CRM data from the Leads, Accounts, Contacts, and 

Deals modules. Some of the benefits of Zoho Writer include:  

• Templates are created online and hence there is no need to download and 

install additional software.  

• Zoho Writer can be accessed by using the single-sign on feature, which 

allows you to access all Zoho products with a single Zoho account login 

credential.  

• Mail merge helps create identical documents such as invitations, forms, 

letters, and envelopes with data from the Leads, Accounts, Contacts and 
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Deals modules. These documents can be printed and mailed—or emailed—

to customers whose details were merged into the documents.  

§ Saves time while creating multiple documents. 

§ Allows easy access to mail merge templates. The templates 

can be edited online anytime.  

Import MS Word 

Mail merge templates can also be created in Microsoft Word and you can import 

those templates to Zoho CRM. To use this functionality, you need to purchase the 

Zoho CRM plug-in for Microsoft Office. Please note that the data-merging feature 

is only supported in Internet Explorer 6 and above.  

To create a template in Zoho Writer 

1. Go to Setup > Customization > Templates > Mail Merge Templates. 

2. In the Mail Merge Templates page, click + Create Template in Zoho Writer. 

3. In the Create Template in Zoho Writer window, specify the following details: 

 
a. Enter the Template Name. 

b. Enter the Description for the template. 

c. Select the Folder from the drop-down list. The template will be 

stored in the folder that you select. 
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d. Select the Module for which you want to create the template. 

The merge fields in the template will be based on the module that 

you select. You can create mail merge templates for both system-

generated modules as well as custom modules. 

4. Click Create. 

A document will be opened in Zoho Writer. 

5. In Writer, click Tools > Mail Merge >Insert Fields and select the field(s) that 

you want to insert. 

 



Zoho CRM for Administrators – Module  5                                                                78   

Activity I-1 
Scenario 

Create a new email template folder named “Email Templates” for storing the email 

templates.  

You need to 

1. On the Email Templates page, select Create New Template.  

2. Once the email template is ready, click Save.  

3. Select New Folder, enter the name of the new folder, and choose with 

whom the folder should be shared. 

 Activity I-2 
Scenario 

Create a new email template named “Lead Template” for welcoming new leads to 

the organization using mail merge. 

You need to 

1. In the Mail Merge select New Template.  

2. Click Create a Template in Zoho Writer, and choose an email template 

folder and the Leads module from the drop-down lists.  

3. A document will open in Writer. Type the text you want to use to welcome 

new leads. 

4. In Writer, click the insert and tools fields (and mail merge within tools) as 

necessary.  
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